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Welcome to Help for CDR® DICOM 

CDR (Computed Dental Radiography) is the hardware / software system designed and manufactured by Sirona Dental to acquire, 
display, and store digital X-rays and video images. DICOM (Digital Imaging and Communications in Medicine) is an open standard 
whose common principles and guidelines are implemented by manufacturers (like Sirona Dental) to communicate digital information 
successfully in diverse hardware and software environments. 

For the latest product information from Sirona Dental, please refer to the on-line support resources listed below.   

  

 
   
Sirona Dental Home Page  
   
Sirona Dental Forums  
  
 

Explanation of Symbols 

Sirona Dental products display a number of markings which indicate compliance with regulatory requirements or which provide 
information in accordance with applicable technical standards. 

Symbol Description 

 
Indicates Class II equipment in accordance with applicable medical device safety standards  
(IEC/EN/UL 60601-1) 

 
Indicates Type BF equipment in accordance with applicable medical device safety standards 
(IEC/EN/UL 60601-1) 

 
Indicates an attention to users to consult accompanying documents (this User Guide) for more 
information 

 
Conforms to European Union Medical Devices Directive (MDD) 93/42/EEC  

 

Indicates that this product meets North American safety standards. The ETL mark is a Nationally 
Recognized Testing Lab (NRTL) marking and indicates conformance with UL 60601-1 and CAN/CSA 
STD C22.2 NO 601.1-M90  

 

Indicates that in the European Union, at the end of product life this device must be disposed of in 
accordance with the requirements of the Waste Electrical and Electronic Equipment (WEEE) directive 
2002/96/EC 

 

Getting Started 

Installing CDR DICOM Server Software 

STEP 1 

Exit the CDR DICOM program if open.   

Insert the CDR DICOM 5.0 disk into your DVD drive. 

Click Install CDR 5.0 Server when the start page is displayed. (If the start page does not display, browse the DVD for the Server 
folder and double-click the CDR DICOM Server Setup file.) 
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• If prompted, click Install to add Microsoft SQL Server files and other updates. 

• Depending on your system, the installation of several prerequisite programs may be required and these may take several 
minutes to install. 

• For a successful installation of CDR DICOM, it is necessary for these prerequisites to install successfully as well, so allow 
the installation to continue until complete. 

Restart your laptop or desktop PC, if prompted. 

STEP 2 

Click Next at the CDR DICOM Server Welcome screen. 

STEP 3 

Click Next after agreeing to the software license agreement. 

STEP 4 

Click Next after entering customer information. 

STEP 5 

Click Next after choosing your database server login preference. 

STEP 6 

Click Next after choosing the folder where your images will be stored. 

STEP 7 

Click Next after choosing the type of setup (Complete). 

STEP 8 

Click Install. 

STEP 9 

Click Finish. 

Continue with the Client setup. 

Installing CDR DICOM Client Software 

STEP 1 

Click Install CDR 5.0 Client when the start page is displayed. (If the start page does not display, browse the DVD for the Client folder 
and double-click the CDR DICOM Client Setup file.) 

• If prompted to install any updates, click Install. 

• Restart your laptop or desktop PC, if prompted. 

STEP 2 

Click Next at the CDR DICOM Client Welcome screen. 

STEP 3 

Click Next after agreeing to the software license agreement. 

STEP 4 

Click Next after entering customer information. 

STEP 5 

Click Next after choosing the type of setup (Complete). 

STEP 6 

Click Install. 

STEP 7 

Click Finish. and remove the CDR DICOM 5.0 disk. 
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Configuring Database 

STEP 1 

Start CDR DICOM by double-clicking on the desktop shortcut. The Configure Database Connection dialog will display. 

• If you are connecting to an external server, click on the down arrow to browse for it. 

• Select the option, “Connect with my Windows login credentials.” 

Click the Test Connection button. 

• If the connection is good, click OK. Installation is complete. 

• If the connection fails, continue with the next step. 

STEP 2 

De-select the option, “Connect with my Windows login credentials.” 

Type in “cdr” (without quotes, all lower case) for the user name and the password. 

Click the Test Connection button. When the connection is good, click OK. 

System Requirements 

The performance of CDR software is affected by the amount of computer and storage memory available to acquire, display, store, 
and print digital X-ray and video images. For recommended requirements, refer to the following guidelines. Please note that your 
patient volume, and the specific demands of your practice, may require you to adjust these guidelines accordingly. Other programs 
operating on the same computer or network may affect these guidelines also. 

CDR CLIENTS 

Computer Hardware Requirement CDR Hardware Requirement Compatible with 

PC-compatible Intel Core 2 processor 
or better 

2 GB RAM or higher 

250 GB Hard Drive (practice-specific, 
depends on number of patients) 

256 MB graphic card 

Intel USB chipset 

At least two powered USB 2.0 parts 
(USB 1.1 also supported) 

Windows 7, Windows Vista, Windows 
XP Professional SP3 

CDR SERVERS 

Computer Hardware Requirement CDR Hardware Requirement Compatible with 

PC-compatible Intel Core 2 processor 
or better 

2 GB RAM or higher 

500 GB Hard Drive or higher 

TCP/IP Networking Protocols (for 
DICOM Servers) 

Windows Server 2003 R2 

Windows Server 2008 R2 

DATABASE PROGRAMS 

Recommended Database Programs 

SQL Server 2005 Express 

Windows Server 2008 
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DISPLAY SETTINGS 

Minimum display requirements for X-rays: 1280 x 1024. To achieve maximum image transfer-to-display time, we recommend quad-
core processors, 8 GB RAM, Windows 7 operating system, and 512 MB graphics card.Exploring Exams 

New Exams 

To start a new exam, click on the New Exam toolbar button. Type in the patient information (first name, last name, ID), or click on 
List to choose from previously entered patients. For new patients, click on the checkbox to create a new patient record. You must 
complete the fields for Patient last and first name and Patient ID. Any letter or number can be used in the Patient ID. 

Several other selections can be made in this dialog box. The Series area displays a selectable list of predefined exam layouts (also 
called viewsets). The Exam area provides for additional Study information, which can be useful for users who desire a greater 
degree of refinement when querying and manipulating information in their patient database. A DICOM accession number, which can 
be used with Patient ID information to specify a particular Study, can also be added. A text area for entering general comments 
about the exam is also available. 

Opening Patient Exams 

To open an existing exam, click on the Open toolbar button. Select an exam from your patient database by searching for it, using 
one of several options available. 

  -- Search by patient (patient first name, last name, or ID) 

  -- Search by study (accession number, comments, or ID) 

  -- Search by date (modify by start and end dates) 

Whether the search is performed by database query or by DICOM exchange depends on the current Data Access setting in the 
CDR Options. (CDR Options are accessible from  the System menu and in the Windows Control Panel.) 

Clicking the Search button initiates the search for a particular patient or study. Search results are displayed in a list box located on 
the dialog box. 

Creating an Xray Series 

CDR provides several pre-defined X-ray series, but you can also choose to create and customize your own. To customize a series, 
open the Edit Viewset dialog box. When this dialog box opens, the rectangular black area (representing the exam window) is initially 
blank. Choose the number of X-ray images to be taken for the designated intraoral areas and enter that number in the appropriate 
box. As the numbers are added, the window fills with view boxes that correspond to those image areas. When the series is 
complete, assign a name to it and click the OK button. 

Creating a Video Series 

CDR provides several pre-defined video series, but you can also choose to create and customize your own. To customize a series, 
open the Video Viewset dialog box. When this dialog box opens, the rectangular black area (representing the exam window) is 
initially blank. Choose the number of video images to be taken for the designated intraoral areas and enter that number in the 
appropriate box. As the numbers are added, the window fills with view boxes that correspond to those image areas. When the series 
is complete, assign a name to it and click the OK button. 

Creating a Panoramic Series 

CDR provides several pre-defined X-ray series, but you can also choose to create and customize your own. To customize a series, 
open the Panoramic Viewset dialog box. When this dialog box opens, the rectangular black area (representing the exam window) is 
initially blank. Choose the number of panoramic images to be taken and enter that number in the appropriate box. As the numbers 
are added, the window fills with view boxes that correspond to those image areas. When the series is complete, assign a name to it 
and click the OK button. 

Creating a TWAIN Series 

CDR provides several pre-defined X-ray series, but you can also choose to create and customize your own. To customize a series, 
open the TWAIN (or Scanner) Viewset dialog box. When this dialog box opens, the rectangular black area (representing the exam 
window) is initially blank. Choose the number of TWAIN images to be imported and enter that number in the appropriate box. As the 
numbers are added, the window fills with view boxes that correspond to those image areas. When the series is complete, assign a 
name to it and click the OK button. 
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Select Series 

This function allows you to select and modify an exam series, even if there are images already in the series. The ability to create 
and save more than one series for an exam is a new feature of CDR DICOM. More information about creating an alternate series 
can be found here. 

When the Series dialog box appears, it lists all the series that are currently available. (This is the same series list that appears in the 
Patient Information dialog box when you create a new exam.) Highlight the appropriate series, then click the Use button to accept 
this series. You may also edit, order, or delete a series from the same dialog box. 

QuickZoom® 

The QuickZoom function is used in the exam window to evaluate all the images in an exam. By panning from image-to-image, a 
zoomed view of the entire series is available. 

QuickZoom can be activated several different ways: by clicking on the QuickZoom button on the toolbar, by selecting QuickZoom 
from the Xray/Image menu, or by using the mouse and right-clicking on the view box and selecting QuickZoom from the context 
menu. Any of these actions prepares the viewing window, switches CDR DICOM to QuickZoom mode, and opens the QuickZoom 
window. Once opened, you do not need to press and hold the mouse button to keep the QuickZoom window active. 

To change a QuickZoom setting, left click again to close the QuickZoom window, then right click for options (Size, Zoom, Shape). 

Right-click to close the QuickZoom window, and right-click to open it again. To exit Quick Zoom mode,  right click and select “Off” 
from the menu. 

   

Save Exam 

By selecting this menu command, all the changes made in the CDR exam window are saved. This choice is available to users who 
wish to ensure their exam information is saved, but in actuality, CDR saves all changes in the exam window. For example, when 
new images are acquired or imported, the exam window can be closed safely without any loss of information even if the step to save 
the exam was not performed. To illustrate by another example, changes in the position and order of images are saved even if the 
Save command is not selected. 

Series Flip 

This feature flips X-rays from one side of the main window to the other. When X-rays are flipped, the patient’s left is shown on the 
left side of the screen. This image arrangement is different from the conventional view where X-rays on the patient’s left side are 
displayed on the right side of the screen. This conventional view (which is also the default setting for CDR) organizes images as if 
the dentist was looking at the patient directly. 

Setup Dentist Information 

Information about the dentist can be included in printed reports and image sets. An unlimited number of sets of dentist information 
may be stored in CDR, although only one may be selected at any time. A dentist information set consists of three sections: 

• Name, which may consist of up to five lines. 

• Address, which may consist of up to five lines. 

• Phone, which may consist of up to four lines. 
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Swap 

Any two images may be swapped, regardless of their orientation. You may also swap an image with an empty view box. To swap 
images, use the left mouse button to select the first image, then hold down the [Shift] key and select the second image. Click on the 
Swap button and the two images will swap positions. 

Tab Format for Exams 

Instead of searching though the patient list each time you want to open other exams for the current patient, use the row of tabs 
along the bottom of the CDR window to open any other exam for the patient. When there are several exams for the same patient, 
you can find the most current one on the right. If there are many exams, arrow keys located in the exam window enable you to scroll 
through the row until you find the exam you want. 

The settings for exam tabs can be found under Options in the System menu. More information about these options can be found 
here. 

Every tab is identified by exam date. A tool tip containing exam and series information appears when you move the cursor over the tab.  

Zoom In 

This function enables you to magnify an acquired X-ray image. Enabling this feature displays the image in the zoom window. Once 
in the zoom window, you can enlarge the image or zoom in further on a particular part of the image in the window. The cursor 
appears as a magnifying glass when the image appears in this mode. 

Acquiring X-ray Images 

Capturing X-ray Images 

Developments in CDR software have expanded the X-ray acquisition choices available to users. Starting with CDR software version 
2.5, users with CDR 2000 systems have the option of taking X-rays in auto-acquisition mode. 

For a short description of auto-acquisition mode, click here. 

For steps on acquiring an X-ray with auto-acquire mode, click here. 

For steps on acquiring X-rays without auto-acquisition, click here. 

X-ray setup and capture options can be found here. 

Intraoral Acquisition Options 

The following list describes configurable options that pertain specifically to acquiring X-ray images with CDR hardware and software. 
These options have a direct bearing on functions performed by CDR software and the communication between it and other 
hardware devices. You should fully understand the impact of making changes to these settings before making changes. 

--  Hardware Type (Displays list of CDR sensor types.) 

--  Exposure Timeout (Displays amount of time CDR waits for exposure before timing out.) 

--  Integrate Phoenix (sec/10) (Displays length of time for integrate mode in APS sensor.) 

--  Integrate Time (sec/10) (Displays amount of time image is accumulated.) 

--  Reset Duration (u/10) (Displays length of time between trigger and acquisition in APS sensor.) 

--  Trigger Thresh (Helps to determine when an image has been acquired.) 

--  Trigger Count (Helps to determine when an image has been acquired.) 

--  I/O Port (Only used for CDR-16 board for port I/O address.) 

--  Initial Rampup (Sec) (Displays time required by sensor before first exposure.) 

--  Second Rampup (Sec) (Displays time required by sensor after first exposure and between subsequent exposures.) 

--  Calibrate Image (When checked, CDR loads calibration file for connected sensor.) 

--  Auto Accept Image (When checked, image is displayed in zoom window immediately.) 

--  Equalize Image (When checked, images are equalized automatically.) 

--  Apply Spot Remover (When checked, Spot Remover is applied to images automatically.) 
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Retake (Accept and Reject) 

You can choose from several options on this dialog window. This includes 

• Accepting the image (which returns you to the exam window with the image in the appropriate target frame) 

• Rejecting the image (which returns you to the exam window) 

• Retaking the image (which returns you to the exam window and prompts you to activate your X-ray source so another 
image can be acquired). This second image will replace the current one. 

Retake (Compare Two Images) 

With this feature you can retake an image a second time and choose which image provides a better picture of the area being X-
rayed. Although this feature can be used after any X-ray, it is helpful when the first X-ray exposure was not optimal. By clicking 
Retake from the File menu, CDR will prompt you to take a second exposure so that it can display both images, side-by-side, for 
comparison. Select one of the images by clicking on the appropriate button (First or Second Take). 

Exposure Quality 

Exposure Quality conveys, in a visual way, an assessment of the image by highlighting a range where image exposure is 
considered optimal. During each image acquisition, CDR software analyzes the acquired image and report its measure of exposure 
quality in the Zoom window. 

  

 
  

Indications on the meter can be interpreted in the following way: 

• At the top of the meter, the range shown in green means that the image has been exposed optimally for the technique 
factors that were used. 

• The range in blue suggests that the image was underexposed and adjusting technique factors would improve image 
quality. 

• The range in orange suggests just the opposite: that the image was overexposed and adjusting technique factors would 
reduce patient dose without reducing image quality.   

If you prefer to have this indication hidden during an exam, it can be turned off manually or hidden permanently. 

• To turn off Exposure Quality so it is hidden permanently from view, go to the System menu in the Exam window and 
select CDR Options.  Select the Windows tab. Click to clear the Show Exposure Meter check box and click OK. 

• To turn off Exposure Quality for the current image in the Zoom window, go to the Windows menu in the Zoom Window 
and uncheck the Display Exposure Meter.  Opening another image in the exam essentially creates a new Zoom window 
for that image and will display the meter again, which can be hidden manually or permanently, as described. 

The Exposure Quality meter will not be available for 8-bit, X-ray images acquired with Schick intra-oral Sensors. For these images, 
the meter will appear dimmed with the wording, “Not Available for this Image,” appearing above it. Customers can enable the meter 
for new images by changing CDR DICOM settings to 12-bit (System > Xray Acquisition Control Properties > Acquire 12 bit image), 
which will display the Exposure Quality meter unless it is hidden intentionally. (Please note that acquiring images in 12-bit mode will 
affect the file size of those images and may increase the time to retrieve them from the image database.) 
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Acquiring Video Images 

Capturing Video Images 

Video images can be acquired when a compatible intraoral camera is configured and connected to the CDR system. Specialized 
exam series, developed specifically for multi-sized video images, are installed as part of CDR's video manager software. By default, 
streaming video images are displayed inside a video window, but they can also be zoomed up to fill the screen display (Full Screen 
button). By suspending the video stream, a single, still frame image can be taken. 

For steps on acquiring a video image, click here. 

For details on Auto Advance during video image acquisition, click here. 

Depending on the type of camera used, additional video setup and capture options can be found here. 

Video Options 

The following list describes configurable options that pertain specifically to acquiring video images with CDR hardware and software. 
You should fully understand the impact of making changes to these settings before making changes. 

• Video Capture Device box (Displays a list of video cards compatible with CDR.) 

• Initial Mode box (Displays the camera mode for capturing video images.) 

• Camera Port box (Displays the I/O address for the CDR camera board.) 

• Use CDR-Cam Controls checkbox (If checked, some settings for the CDR-Cam intraoral camera can be modified. 
Unchecked box means this setting does not apply.) 

• Auto White Balance checkbox (If checked, automatic white balance is on when capturing video in extra-oral mode. 
Unchecked box means that auto white balance is off.) 

• Turn Light Source On checkbox (If checked, the camera light source is turned on. Unchecked box means that the camera 
light source is off.) 

Acquiring Panoramic Images 

Capturing Panoramic Images 

Panoramic images can be acquired when a compatible panoramic host machine is configured with iPan or iPan HS hardware and 
software. (A current list of compatible panoramic machines can be found on our website.) Specialized exam series, developed 
specifically for panoramic images, are installed as part of CDR's panoramic software. 

For steps on acquiring a panoramic X-ray, click here. 

Panoramic setup and capture options can be found here. 

Panoramic Options 

Please Note: Casual changes to the Acquisition Modules section can adversely affect the performance of the CDR system. We do 
not recommend making changes in this section unless directed to do so by authorized support personnel. 

--  Panoramic Device Driver Name (Displays the name of the device driver for the panoramic system.) 

--  Scan Direction (Drop-down menu displays list of travel options for the panoramic machine.) 

--  Image Width (Numeric value for the number of rows in the panoramic image. Also called LX.) 
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--  Image Height (Numeric value indicates the number of columns in the panoramic image. Also called LY.) 

--  Initial Timeout (Numeric value indicates the amount of time CDR will wait for the panoramic machine to start motion when CDR is 
in acquisition mode.) 

--  Early Stop Timeout (Numeric value indicates the maximum number of seconds CDR can take to read a column of pixels before it 
times out.) 

--  Resend (When checked, retrieves the last acquired image from the buffer inside the Sensor and displays it in an empty, user-
selected viewbox.) 

--  Calibrate Image (When checked, indicates that CDR loads the calibration file for the connected panoramic sensor.) 

--  Equalize Image (When checked, indicates that Equalize is applied automatically each time a panoramic image is acquired.) 

--  Apply Spot Remover (When checked, indicates that Spot Remover is applied automatically each time a panoramic image is 
acquired.) 

--  Subtract Dark Image (When checked, indicates that CDR applies subtraction to eliminate the noise caused by dark signal in the 
sensor.) 

--  Acquire 12 bit image (When checked, indicates that the image is acquired at a higher 12-bit depth.) 

--  Automatic Exposure Control (When checked, indicates that slight under- or over-exposed X-rays will be corrected automatically.) 

--  Auto Resend (When checked, indicates that, if electronic interference has affected a panoramic image during acquisition, an 
uncorrupted image may be available from the memory buffer inside the Sensor and retrieved automatically.) 

--  Mapping (When checked, indicates that a particular mapping is applied to show more image detail in mid-range pixel values 
[traditional], or in upper and lower pixel values [arcsine], or mapped exactly to the image values that can be displayed [linear].) 

Panoramic Calibration Options 

The following list describes configurable options that pertain specifically to calibrating panoramic images with CDR hardware and 
software. These options have a direct bearing on functions performed by CDR software and the communication between it and 
other hardware devices. You should fully understand the impact of making changes to these settings before making changes. 

--  Calibration File Path (Displays the path where calibration files for panoramic sensors are stored.) 

--  Gap Width (Displays the number of blank rows between the panoramic sub-sensors.) 

--  Calibration Threshold (Displays the percentage above which raw pixels are not calibrated.) 

--  Dark Threshold (Displays the threshold percentage above which dark subtraction is not applied to raw pixels.) 

--  Extra Bad Rows (When checked, indicates that two additional blank rows are marked bad and are added between the panoramic 
sub-sensors.) 

--  Clip Saturated Pixels (When checked, dark subtraction is modified for pixels with values between 99 and 100%.) 

--  Sirona Orthophos System (When checked, accommodates the particular design of this system in which the Sensor is inverted 
when installed.) 

Acquiring Cephalometric Images 

Capturing Cephalometric Images 

Cephalometric images can be acquired when a compatible panoramic host machine is configured with cephalometric hardware and 
software. (A current list of compatible panoramic machines can be found on our website.) Specialized exam series, developed 
specifically for cephalometric images, are installed as part of CDR's cephalometric software. 

For steps on acquiring a cephalometric X-ray, click here. 

Cephalometric setup and capture options can be found here. 

Cephalometric Options 

Please Note: Casual changes to the Acquisition Modules section can adversely affect the performance of the CDR system. We do 
not recommend making changes in this section unless directed to do so by authorized support personnel. 

--  Cephalometric Device Driver Name (Displays the name of the device driver for the cephalometric system) 

--  Timeout (Numeric value indicates the amount of time CDR will wait for the cephalometric hardware when CDR is in 
cephalometric acquisition mode) 

--  Hardware Info (When pressed, provides hardware information about the cephalometric system) 
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--  Resend (When checked, indicates that the last acquired image will be retrieved from the system memory and displayed in the 
currently selected viewbox) 

--  Calibrate Image (When checked, indicates that CDR loads the calibration file for the connected cephalometric sensor) 

--  Apply Spot Remover (When checked, indicates that Spot Remover, which can help remove noise and image artifacts,  is applied 
automatically each time a cephalometric image is acquired) 

--  Acquire 12 bit image (When checked, indicates that the image is acquired at a higher 12-bit depth) 

--  Mapping  (Indicates that a particular mapping is applied to show more image detail in mid-range pixel values (sinusoidal), in 
upper and lower pixel values (arcsine), or linearly (pixel values mapped exactly to the image values that can be displayed) 

Calibration Options 

The following list describes configurable options that pertain specifically to calibrating cephalometric images with CDR hardware and 
software. These options have a direct bearing on functions performed by CDR software and the communication between it and 
other hardware devices. You should fully understand the impact of making changes to these settings before making changes. 

--  Calibration File Path (Displays the path where calibration files for cephalometric sensors are stored.) 

--  Calibration Threshold (Displays the percentage above which raw pixels are not calibrated.) 

--  Dark Threshold (Displays the threshold percentage above which dark subtraction is not applied to raw pixels.) 

Acquiring TWAIN Images 

Capturing TWAIN Images 

Images can be acquired directly into CDR from TWAIN devices (scanners, digital cameras, or other digital sources).This feature can 
be especially helpful for users who want to scan film X-rays into digital format. Both 24-bit color and 8-bit black & white images can 
be imported from a TWAIN device. 

For steps on acquiring a TWAIN image, click here. 

TWAIN messages can be found here. 

Select TWAIN Source 

If you use more than one TWAIN device on your system, you will need to choose which source you intend to use before acquiring 
images from that device into CDR. Choosing this menu command opens the same list of TWAIN devices used by your scanning 
software. 

TWAIN Messages 

When acquiring images into CDR from a TWAIN source (scanner, digital camera, or other digital source), CDR may remind you of 
the following: 

  -- CDR will only accept  24-bit color images and 8-bit black and white images. 

  -- CDR will rotate the image if necessary to match the orientation of the target frame. 

These messages can be suppressed either on the message dialog box itself or through CDR Options. 
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Sending Exams and Images 

Sharing Images 

This feature allows CDR DICOM users to exchange X-ray and video images electronically over a networked system or the Internet. 

The following options for image sharing are available: 

• E-mail images individually or by series in the popular JPEG format. 

• Save a CDRZIP file so it can be e-mailed from another location if necessary. 

• Save JPEG images to another location. 

• Create an exam “postcard” for patients or other professionals. 

Sending X-rays (Web Viewer) 

This function enables users to export all the images in an exam to an HTML page that can be viewed with Internet Explorer 5 or 
later. (Internet Explorer 5 is distributed with CDR DICOM software and can be installed from the IE folder located on the CD.) The 
images are exported in JPEG format and complete exam information is included as well. No CDR software is required. 

You can use this feature to save a full mouth series exam to a disk and give it to your patients. They can take it home and view it on 
their own PC without any accompanying software. 

Sending and Viewing X-rays 

1. Open a patient exam from either the menu bar at the CDR exam window or by clicking on the Open button in the toolbar. 

2. Click File > Send to > Web Viewer. 

3. All of the images in the exam are exported, in JPEG format, to a single HTML page. 

4. When prompted, enter a name and location to save the file. 

Internet Explorer will start automatically and display the exam and images in an HTML page. The HTML page can be saved to a 
floppy disk or other portable media. Other users can also view this file, provided they have a compatible version of Internet Explorer. 
Neither CDR DICOM nor another DICOM viewer is needed. 

Reviewing Images 

Brightness 

Image brightness can be adjusted in two different ways: 

• By moving the slider to the left (where the image approaches 100% black) or to the right (where the image approaches 
100% white). When image brightness is maximized, all pixels are 100% white. When image brightness is minimized, all 
pixels are 100% black. 

• By right-clicking on the image, selecting the Brightness/Contrast option, and moving the icon up or down (with the same 
result as above). 

To adjust image brightness using the second option, perform the following steps: 

1. Move your cursor over an image in the CDR Zoom Window. 

2. Press the right-mouse button to open a short menu. 

3. Select Brightness / Contrast. 

4. Press down and hold the left-mouse button, which changes the Brightness / Contrast icon to a two-arrow cursor. 

5. Keeping the mouse button depressed, move the cursor up to increase brightness. Moving the cursor down decreases 
brightness. 

Brightness / Contrast remain active until another tool (like Pan or Zoom) is selected. 

To restore the brightness of an image to its original setting, click Normal from the Contrast menu. If you are adjusting Brightness and 
Contrast using the icon, double-click on the image to achieve the same result 
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Colorize 

The colorize option produces a pseudo color image. To colorize an image, select Colorize from the Enhance zoom menu or click the 
Colorize icon on the toolbar. 

 

Contrast 

Image contrast can be adjusted in two different ways: 

• By moving the Contrast slider to the left (where the image approaches 100% gray) or to the right (where the image 
approaches 50% white, 50% black) 

• By right-clicking on the image, selecting the Brightness/Contrast option, and moving the icon to the left or the right (with 
the same result as above). 

To adjust image contrast using the second option, perform the following steps: 

1. Move your cursor over an image in the CDR Zoom Window. 

2. Press the right-mouse button to open a short menu. 

3. Select Brightness / Contrast. 

4. Press down and hold the left-mouse button, which changes the Brightness / Contrast icon to a two-arrow cursor. 

5. Keeping the mouse button depressed, move the cursor to the right to increase contrast. Moving the cursor to the left 
decreases contrast. 

Brightness / Contrast remain active until another tool (like Pan or Zoom) is selected.  

Emboss 

Emboss enhances an X-ray image by giving it the appearance of three-dimensional depth. Once Emboss has been applied, 
selecting the feature from the menu reapplies the filter. To undo Emboss, use the change list box under the Edit menu. 

The following images exemplify the effect of the Emboss feature on a typical X-ray. (Emboss cannot be used for video images.) 

       
(Before Embossing)                                         (After Embossing)  

Equalize 

For some exposures, the darkest pixels will not be all black. The equalize function will stretch the contrast of an image so that the 
darkest pixels will be made all black. To save the equalized image, click on Save. To equalize an image, select Equalize from the 
Enhance zoom menu or click the Equalize button. 
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Please Note: If all images are underexposed, increase the setting on the X-ray source so that the darkest areas on an image are 
nearly all black. As with film, exposures in different areas of the mouth may require different settings. 

Flashlight 

Select Flashlight from the Contrast menu or click the Flashlight button from the toolbar. Once the flashlight beam appears, right-
clicking on the image displays a popup menu so other beam sizes can be selected. It is also possible to suspend the Flashlight 
beam so that other enhancement features can be used. 

Some enhancements can be applied to the entire image without affecting the area inside the Flashlight beam. Colorize and Positive, 
for example, work this way. To see this, click on either toolbar icon while the Flashlight beam is on. 

 

Grid 

Use the Grid function to display a 1mm by 1mm grid on top of the image. Select Grid a second time to remove the grid. 

 

Highlight 

To check the progression of a tooth or the work being done, an image can be highlighted. To highlight an image, select Highlight 
from the Enhance zoom menu. Once in the Highlight screen, you will see a mouse pointer in the shape of a paint can. 

Click on the area of the  image that you would like to highlight. When the color palette appears, choose the color that you would like 
to use to highlight the selected area. To adjust the color intensity and area of color, use the paint scroll bar. 

   
(Highlight On)  
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Histogram 

The histogram function displays a graph of pixel values beneath the line shown on the screen. To create a histogram, select 
Histogram from the Measure menu. Choose horizontal, vertical, or line for the desired direction and length. To create a histogram 
file, answer yes or no, and the file will be saved as an ASCII file with the pixel values. 

 

Editing and Inserting Notes 

To edit notes, perform the following steps. From the Notes menu, select Edit. Move the mouse pointer over the note flag. Click the 
left mouse button. Edit the note using the backspace key or the delete key to erase text. Click OK. 

To insert new notes, perform the following steps. From the Notes menu select Insert. Move the mouse pointer over the image, then 
click the left mouse button to position the note flag. Click any of the predefined buttons, shortcuts, or enter information in the Note 
text box. Click OK.   

List All Changes 

This feature tracks all enhancement changes to an image and can be used for reference when removing changes using the Undo 
feature and reapplying them with Redo. Changes are undone one at a time and every enhancement change that was applied to an 
image can be removed and re-applied. 

The date and the time the enhancement changes were made are also listed in the dialog box. 

Maximize Contrast 

Select the Contrast menu then Maximize Contrast. 

Please Note: Maximizing contrast in the Contrast menu will make the darkest pixels all black and the lightest pixels all white. This enhancement 
will map more mid-range gray pixels to either black or white, creating sharper distinctions in contrast.  

Pan Mode 

The Pan tool is used with Zoom, enabling inspection of adjoining areas of a magnified image at the same magnification. 

To pan around the image, perform the following steps: 

1.  Move your cursor over an image in the CDR Zoom Window. 

2.  Press the right-mouse button to open a short menu. 

3. Select Pan. 

4. Press down and hold the left-mouse button, which changes the Pan icon to a four-arrow cursor. 

5. Keeping the mouse button depressed, move the cursor either up/down or left/right to pan around the image. 

Pan remains active until another tool (like Zoom or Brightness / Contrast) is selected. 
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Pixel Value 

To show pixel values for a image, select Pixel Value from the Measure zoom menu. Click anywhere on the X-ray and the grayscale 
value of that pixel is displayed in the status bar. 

Please Note: An all black pixel is 100% and an all white pixel is 0%.  

Positive 

To change a negative to positive image, select Positive from the Enhance zoom menu or click the Positive button on the toolbar. To 
return to original display, repeat the action. 

       

Sharpen 

Passes the image through a filter that accentuates edges in the image. To sharpen the image, select Sharpen from the Enhance 
zoom menu. 

 

Sharpen and High-Resolution Images 

Sharpen is a tool for image enhancement developed specifically for Schick 33 images. Sharpen uses a combination of different 
functions to optimize Schick 33 images for detail and contrast. It is applied automatically to every image taken with Schick 33 
Sensors. 

To adjust image sharpness dynamically, a Sharpen slider and a Sharpen cursor are available. The slider can be shown or hidden. It 
can also be positioned at the Top or Bottom areas outside the image, or as an Overlay on the image. 

Showing the Sharpen Slider 

Hiding the Sharpen Slider 

Positioning the Sharpen Slider 

Using the Sharpen Slider 

Using the Sharpen Cursor 

Using Sharpen with other Image Enhancements 

SkyWriter™ 

This function enables you to annotate an X-ray using a freehand drawing tool. You have the option of selecting line width and color, 
and applicator style. You may also change the color of the annotations once you've added them to the image. You can draw using 
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any color, which will apply to all the annotations on that image. After they are applied to an image, annotations can also be hidden 
(by turning them off) or removed completely (by erasing them). 

Like other enhancement changes, annotations can be saved with image and viewed again when the image is retrieved. 

 

Spot Remover 

This will remove fixed pattern noise that may appear on some images. To remove these small defects in the image, select Spot 
Remover from the Enhance zoom menu. Spot Remover can also be applied automatically after image acquisition by enabling this 
option in System Options, or whenever Revealer is applied by enabling this option in Enhance Options. 

Tile Images 

This function lets you view multiple images in a tiled (non-overlapping) arrangement. 

When you open two or more images, it is possible to tile them so you can see all of the images at once on your display. You can 
also control the tiling arrangement. To use the tiling feature, select two or more images from the current exam and select a tiling 
option from the Windows menu or from the Tile icon down arrow on the toolbar. 

There are three tiling options: 

• Tile Vertical 

• Tile Horizontal 

• Tile Multiple. 

If you choose Tile Vertical, the images will appear one below another. In Tile Horizontal, the images are displayed side-by-side. The 
Tile Multiple option orders the images automatically to optimize their viewing. 

NOTE: If you intend to tile images, open each image from the Exam window: do not use the thumbnail exam on the Zoom window. 
Using the mini-exam window “recycles” images in the same Zoom window. Tiling requires at least two images, each in its own Zoom 
window. 

How can you tell how many images are open at one time? One way is to check your Windows taskbar, found usually at the bottom 
of your Windows desktop. Each time an image is opened in CDR DICOM, a button is placed on the taskbar. 

When images are tiled, they are resized to fit inside the Exam window. As the number of tiled images increases, the size of each 
image – how large it appears in the Zoom window – decreases. This is important to remember since opening too many images at 
the same time will make them difficult to see even with the tile feature active. Selecting Hide Extras from the Window menu of each 
Zoom window provides some extra space for each image. 

User Profiles 

User profiles make it possible to customize Sharpen slider settings so you can pre-select the appropriate amount of image 
sharpening for commonly-performed clinical tasks, such as Endodontic, Periodontic, General Dentistry, and Restorative. 

Adding a User Name 
 In the CDR Zoom Window, right-click on an image acquired with a Schick 33 Sensor. 

1. Click on the Edit Users menu item. 

2. Click on the Add User button. 

3. Click inside the New User name text box and type in a user name. 

4. Click Close. 

 To verify, right-click on the image again and click on Select User. The new user name will appear in the menu. 
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Editing a User Name 
In the Zoom window, right-click on an image acquired with a Schick 33 Sensor. 

1. Click on the Edit Users menu item. 

2. Locate the user name you wish to edit. 

3. Double-click on the user name, which becomes an editable text box. 

4. Type in a new name for this user. 

5. Click Close. 

To verify, right-click on the image again and click on Select User. The edited name will appear in the menu. 

Deleting a User  
In the Zoom window, right-click on an image acquired with a Schick 33 Sensor. 

1. Click on the Edit Users menu item. 

2. Select the user name you wish to delete from the list. 

3. Click on the Delete user button. 

4. Click Close. 

Editing a Task 
In the Zoom window, right-click on an image acquired with a Schick 33 Sensor. 

1. Click on the Select User menu item. 

2. Select a user name from the list. 

Note: The [default] name is not editable. To create your own custom profile, add a user name and then perform the following steps 

1. Right-click on the image again and click on the Select Task. 

2. Choose one of the task categories from the list. 

3. Adjust the slider to a level of Sharpening that you feel is appropriate. 

4. Click on the Save as default button. 

5. When prompted, click Yes to save the new the Sharpen value as the default setting for this task category and this user. 

To check or compare the Sharpen settings with other user profiles or default values, click on Edit User, which opens the user profile 
dialog. 

Zoom Mode 

The Zoom tool supports pre-defined settings to magnify an image to 500% or to return it to original size, using just double-mouse 
clicks when Zoom mode is selected. Zoom is the default mode in the image window, so these actions can be performed 
immediately. 

To use pre-defined Zoom settings, perform the following steps: 

1. Move your cursor over any area of the image in the CDR Zoom Window you wish to magnify. 

2. Using the left-mouse button, double-click to magnify the image to 500%. 

3. Double-click again to return the image to 100%. 

Adjusting the zoom levels manually, from 20% to 3000%, is also available. To magnify the image manually, perform the following 
steps: 

1. Move your cursor over an image in the CDR Zoom Window. 

2. Press the right-mouse button to open a short menu. 

3. Select Zoom. 

4. Press down and hold the left-mouse button, which changes the Zoom icon to a two-arrow cursor. 

5. Keeping the mouse button depressed, move the cursor in an upward direction to increase the zoom level. 

6. Keeping the mouse button depressed, move the cursor in a downward direction to decrease the zoom level. 

Zoom remains active until another tool (like Pan or Brightness / Contrast) is selected. 
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Sharing Images 

This feature allows CDR DICOM users to exchange X-ray and video images electronically over a networked system or the Internet. 

The following options for image sharing are available: 

• E-mail images individually or by series in the popular JPEG format. 

• Save a CDRZIP file so it can be e-mailed from another location if necessary. 

• Save JPEG images to another location. 

• Create an exam “postcard” for patients or other professionals. 

Sending JPEGs by Email 

STEP 1 

Open an exam in CDR DICOM that contains the image(s) you wish to send or save. 

STEP 2 

• Select the image(s). If there are several, use the <SHIFT> key to add them. To select all the images, press <CTRL> and 
<A>. 

• Click the Mail button on the toolbar. 

STEP 3 

• Select “JPEG” when the Send Mail dialog opens. 

• Select “Email.” 

• Click “Send Email.” 

STEP 4 

Your mail program opens with JPEG(s) attached. 

Saving CDRZIP File 

STEP 1 

Open an exam in CDR DICOM that contains the image(s) you wish to send or save. 

STEP 2 

• Select the image(s). If there are several, use the <SHIFT> key to add them. To select all the images, press <CTRL> and 
<A>. 

• Click the Mail button on the toolbar. 

STEP 3 

• Select “CDRZIP” when the Send Mail dialog opens. 

• Select “File.” 

• Click “Generate Attachment.” 

STEP 4 

When prompted, browse to a location on your system and click Save. 

Saving JPEGs to Other Location 

STEP 1 

Open an exam in CDR DICOM that contains the image(s) you wish to send or save. 

STEP 2 

• Select the image(s). If there are several, use the <SHIFT> key to add them. To select all the images, press <CTRL> and 
<A>. 
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• Click the Mail button on the toolbar. 

STEP 3 

• Select “JPEG” when the Send Mail dialog opens. 

• Select “File.” 

• Click “Generate Attachment.” 

STEP 4 

• When prompted, browse to a location on your system and click Save. 

The image(s) are saved in one folder. The image(s) can be browsed, copied to CD, uploaded to file, or printed. 

Sending Postcard by Email 

STEP 1 

Open an exam in CDR DICOM that contains the image(s) you wish to send or save. 

STEP 2 

• Select the image(s). If there are several, use the <SHIFT> key to add them. To select all the images, press <CTRL> and 
<A>. 

• Click the Mail button on the toolbar. 

STEP 3 

• Select “Postcard” when the Send Mail dialog opens. 

• Select “Email.” 

• Click “Send Email.” 

STEP 4 

Your mail program opens with the exam Postcard attached. 

Additional details about Postcard options can be found here. 

  

Printing Reports and Images 

Print One Image in the Exam Window 

To print the currently selected image in the main window, choose Print One from the Print menu. When printing one image from the 
main window, the last saved version of the current image is printed at 100%, unless the Fit to page option is checked, which 
maximizes the image to occupy more space on the printed page. 

Print Image in the Zoom Window 

To print an image in the zoom window, choose Print from the File menu or click on the Print button on the toolbar. When printing 
from the zoom window, only the current image, and not the rest of the images in the exam, will be printed. The printed image will 
reflect all the enhancements applied in the zoom window (zoom level, contrast, colorize, etc.). These changes will appear in the 
printed copy even if the changes themselves were not saved. 

Print Set 

To print all the images in the current exam, select Print Set from the Print menu or click on the Print Set button on the toolbar. Like 
the Print command for printing one image, you can have patient and dentist information appear on the printed copy. If you prefer to 
have the images print slightly larger, clear the checkmarks under the Print Options area of the dialog box, or check the Fit to page 
option. Fit to page maximizes the size of the images on the printed page (within some limitations; for example, page margins and 
number of images). 



 

20 B1055027 Rev. - CDR DICOM User Guide (English) 
 

Word Template 

This function allows you to create report templates using Microsoft Word. If you prefer to work with the Word templates that were 
supplied with CDR, feel free to customize them to your particular needs. Any Word templates you are using already can also be 
added quickly and easily to the Reports menu. For more information on how to do this, follow the link below: 

Organize Reports 

A sample Word template provided with CDR is shown below: 

 

 

Servers and Databases 

Database Properties 

Storing images is accomplished by connecting to either an SQL database or to a DICOM server (over a TCP/IP network). When an 
SQL database is used, it provides the means to query / store/ retrieve information about the patient, study, series, and image. The 
images themselves are stored on the server hard drive in DICOM readable format. 

When the SQL database has been correctly configured to store image information, several important settings are directly accessible 
from CDR. The CDR Options selection under the System menu is a common point for storage information about CDR images. 
Under the Data Access tab, click on the Advanced button for specific information about your current storage configuration. 

ODBC Errors 

As an additional tool for addressing issues with databases, CDR provides the means to capture and log errors that could occur while 
it is interacting with the database. Under the Data Access tab, click on the Advanced button. The ODBC Errors tab includes a 
checkbox for activating the logging feature and a text field that specifies the location of the log file. 
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DICOM Server Properties 

Storing images is accomplished by connecting to either an SQL database or to a DICOM server (over a TCP/IP network). When an 
DICOM server is used, it provides the means to query / store/ retrieve information about any patient, study, series, and image. The 
images themselves are stored on the server hard drive in DICOM-readable format. 

When a DICOM server has been correctly configured to store image information, several important settings are directly accessible 
from CDR. The CDR Options selection under the System menu is a common point for storage information about CDR images. 
Under the Data Access tab,  click on the Advanced button for specific information about your current configuration. 

The TCP/IP connection to a selected DICOM server can be verified via CDR Options. In addition, DICOM servers can be added, 
modified, or removed. Other storage options (using a patient worklist or retrieval from media) are also available. 

Local Properties 

Configuration settings for the currently selected DICOM server can found in CDR Options.  Under the Data Access tab, choose the 
storage option that applies to your system (in this case DICOM server or CDRDATADICOM.DLL) and click on the Advanced button 
for specific information about your current configuration. 

The following information is available: 

-- IP Address (local IP address) 

-- Computer Name (local computer name) 

-- Local Port (Port designated to listen for TCP/IP connections) 

-- Local AE Title (Local Application Entity title of local computer) 

-- Remote AE Title (Remote Application Entity title of local computer) 

-- Local Incoming Directory Cache (location for storing images) 

-- Enable Logging to File (location of file where DICOM messages are logged) 

Menus 

Exam File Menu 

Use the options on the File menu to open an exam window for a  new patient, start a new exam, open an existing exam, save an 
exam, view a list of recently opened exams, mail an exam over a network or the Internet, export the exam as an HTML page, and 
exit CDR. 

More information about items listed in this menu can be found below. 

New Patient Window 

New Exam 

Open 

Save 

Send To E-mail Recipient 

Send to Web Viewer 

Exam Edit Menu 

Use the options on the Edit menu to copy and paste images,and  to select all the images in the current exam. 

More information about items listed in this menu can be found below. 

Copy 

Paste 

Select All 

Edit Exam Comments 
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Exam View Menu 

Use the options on the View menu to toggle on and off  the following items and areas on the exam window -- toolbar, status bar, and 
exam information. The Full screen menu option maximizes the exam and hides all other information. When Full screen is active, an 
icon appears on the display to toggle back to the exam window. 

More information about items listed in this menu can be found below. 

Toolbar 

Status Bar 

Exam Info 

Full Screen 

Application Look 

Exam Xray/Image Menu 

Use the options in the X-ray/Image menu to take an X-ray (if the selected view box is empty) or retake an X-ray (if the view box 
contains an image), view an image in a zoom window,select an acquisition mode (X-ray, video, panoramic, or TWAIN), swap 
images, detach images from the exam, import an image (if the selected view box is empty) or export an image (if the view box 
contains an image), QuickZoom X-rays, manually acquire or auto-acquire (AutoTake) images, and set the target frame color and 
flash interval when the auto-acquire mode is active. 

Take / Retake X-ray 

Zoom In 

X-ray Acquisition Mode 

Video Acquisition Mode 

Panoramic Acquisition Mode 

Scanner (TWAIN) Acquisition Mode 

Swap 

Detach 

Import 

Export 

QuickZoom 

AutoTake 

Exam Series Menu 

Use the options in the Series menu to change the number of images in a new or empty series, select a series, change the order of 
images in a series, move images to the opposite side of the exam, reload images in the current exam, and create a new standard or 
grid X-ray series, new video series, or new panoramic series. 

Edit 

Select 

Order 

Flip 

Reload 

New Intraoral, Video, or Panoramic Series 

Exam Print Menu 

Use the options in the Print menu to print images in an exam, print one image, and add, organize, and prepare templates and 
reports using Microsoft ® Word ®. 

Print Set 

Print One 

Add Report 
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Organize Reports 

Exam System Menu 

Use the options in the System menu to check sensor information, add or edit dentist and dental practice information, define note 
short-cuts, and review and / or modify various configuration settings for your CDR system and software. 

Sensor Info 

Setup Dentist Info 

Define Note Shortcuts 

Options 

Exam Window Menu 

Use the options in the Window menu to tile images (no overlap) and stack images. 

Tile Images 

Stack Images 

Exam Help Menu 

Use the options in this menu to open the help file for CDR DICOM software, to link to an on-line support page on the Schick 
Technologies website specifically for CDR DICOM software, and to display version and other information about the software. 

Contents 

CDRDicom on the Web... 

About CDRDicom...  

Zoom File Menu 

Use the options in this menu to save an image, retake an image, print the current image, and close the zoom window. 

Save Image 

Retake 

Print 

Close Window 

Zoom Edit Menu 

Use the options in this menu to track all enhancement changes to an image, to remove enhancement changes from the image, and 
to re-apply them. 

Undo 

Redo 

List All Changes 

Zoom Menu 

Use the options in this menu to view an image in zoom mode, zoom an image 2x, zoom out 2x, full zoom an image to 100%, zoom 
the entire window, pan around zoomed images, and enable Skywriter -- an annotation tool for drawing on the current image. 

Zoom Mode 

Zoom in 2x 

Zoom Out 2x 

Zoom Full 

Zoom Window 



 

24 B1055027 Rev. - CDR DICOM User Guide (English) 
 

Pan Mode 

SkyWriter 

Zoom Enhance Menu 

Use the features in this menu to apply Revealer -- an improved image contrast tool, colorize images, toggle negative and positive 
views of an image, sharpen images, filter out white spots caused by fixed pattern noise, equalize images, emboss, and highlight 
images with color. 

Revealer 

Colorize 

Positive 

Sharpen 

Spot Remover 

Equalize 

Emboss 

Highlight 

Zoom Measure Menu 

Use the options in this menu to obtain pixel values, perform distance and angle measurements, place a grid over an image, and 
create histograms. 

Pixel Value 

Calibrate 

Reset Calibration 

Straight Line 

Multiple Lines 

Angles 

Grid 

Density Profile 

Zoom Notes Menu 

Use the options in this menu to insert notes (shown as numbered flags) on an image. This menu can also be used to delete or edit 
notes, list all notes, add or edit global notes, and hide note flags. 

Insert 

Delete 

Edit 

List All 

Global 

Hide Flags 

Zoom Contrast Menu 

Use the options in this menu to help change the contrast and brightness of X-ray images. Image contrast can be increased, 
decreased, and maximized. The image can also be darkened, lightened, reset to its original contrast and brightness, or enhanced in 
a small-to-large circular region using the Flashlight feature. 

Increase Contrast 

Decrease Contrast 

Maximize Contrast 

Flashlight 
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Darken 

Lighten 

Normal 

Zoom Reorient Menu 

Use the options in this menu to flip images left, right, up, and down. Images can also be rotated 180 degrees or reset to their original 
positions. 

Flip Left/Right 

Flip Up/Down 

Rotate 90 Degrees 

Rotate 180 Degrees 

Normal 

Zoom Window Menu 

Use the options in this menu to display the zoom window toolbar, mini view window, status bar, 1 mm tick marks along the zoom 
window, and mini-exam window. Selecting Hide Extras can hide these items. Like exams, images can also be tiled or stacked. 

Display Toolbar 

Display Mini-View 

Display Status 

Display Tick Marks 

Display Exposure Meter 

Display Exam 

Hide Extras 

Tile Images 

Stack Images 

Task Menu 

Use the options in this window to select clinical tasks (which have customizable Sharpen slider settings for Schick 33 images) and 
user profiles. 

Tasks 

User Profiles 

Zoom Help Menu 

Use the options in this menu to open the help file for CDR DICOM software, to identify principal areas of the Zoom window, and for 
information about the current image, including DICOM tags. 

Contents 

Help on Zoom 

Image Information 

  

Tool Bars 

Exam Toolbar 

Click on any icon for a brief description. 
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Zoom Toolbar 

Click on any image for a brief description. 

 

Windows 

Exam Window Locator 

The following graphic is a sample of a typical exam window in CDR. Click on any area in the graphic below for the names and 
functions of items found on the exam window. 

 

Zoom Window Locator 

The following graphic is a sample of a typical image inside a CDR zoom window. Click on any area in the graphic below for the 
names and functions of items found on the zoom window. 
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How Do I . . . 

Compress Images 

Compressing X-ray images offers several benefits, including: 

• Increased efficiency in the use of space allocated for storing images 

• Increased image retrieval and display time because the file sizes are smaller 

• And for the same reason – increased portability and electronic mailability 

The following compression formats are supported: 

• Low Compression (High Quality) (2:1) No comparable compression type in previous versions of CDR 

• Medium Compression (Medium Quality) (5:1) Compares with Lead PQ1 compression (5:1) in previous versions of CDR 

• High Compression (Low Quality (20:1) Compares with JPEG compression (17:1) in previous versions of CDR 

For images acquired with Schick 33 Sensors, all compression settings will default automatically to High Quality. Customers should 
note that Schick 33 images, with compression, will require a longer time to load and display than uncompressed Schick 33 images 

  

Compression settings can be selected in several different modules of CDR DICOM: 

Data Administration Utility 

CDR Client 

Create My Own Word Template 

Templates are special types of documents -- starting points really -- that can be used to generate patient reports. Using our macros, 
you build documents that merge standard information (information about your dental practice, for example) with specific information 
intended for the report (patient name, images, image date, and current date). 

1. Start CDR. Click Print > Add Report > New MS Word Template Report. Word opens a blank template (blank.dot) and 
displays a special toolbar for creating CDR templates. This toolbar, which consists of First Name, Last Name, Exam, and 
Insert Image entries, is displayed above the text window. 

2. Enter the text portion of your template and any other logos or graphics you wish to include with this document. In the 
appropriate places, click First Name and Last Name on the special toolbar to add the fields where a patient's name will 
appear. Do the same to add the Exam Date field to the template. 
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3. Enter the image boxes (as many as you wish and / or can fit on the template) by clicking on Insert Image. When the CDR 
Image dialog appears, fill in the Image # (1 for first image), select the orientation (vertical or horizontal), and the show date 
option. Click OK. 

4. Repeat Steps 2 and 3 as needed to complete the template. When finished, click File > Save As, select a folder (preferably 
"Reports") and provide a name for the template. Saving the template to the Reports folder adds it to the CDR Reports 
menu. 

Sending JPEGs by Email 

STEP 1 

Open an exam in CDR DICOM that contains the image(s) you wish to send or save. 

STEP 2 

• Select the image(s). If there are several, use the <SHIFT> key to add them. To select all the images, press <CTRL> and 
<A>. 

• Click the Mail button on the toolbar. 

STEP 3 

• Select “JPEG” when the Send Mail dialog opens. 

• Select “Email.” 

• Click “Send Email.” 

STEP 4 

Your mail program opens with JPEG(s) attached. 

Procedure to Send and View X-rays by Web Viewer 

1. Open a patient exam from either the menu bar at the CDR exam window or by clicking on the Open button in the toolbar. 

2. Click File > Send to > Web Viewer. 

3. All of the images in the exam are exported, in JPEG format, to a single HTML page. When prompted, enter a name and 
location to save the file. 

4. Internet Explorer will start automatically and display the exam and images in an HTML page. The HTML page can be 
saved to a floppy disk or other portable media. Other users can also view this file, provided they have a compatible 
version of Internet Explorer. Neither CDR DICOM nor another DICOM viewer is needed. 

Create Alternate Series 

Sometimes, the series originally selected for an exam is not the most appropriate one. In previous versions of CDR, a series used in 
a current exam could not be changed after an image was added to it. In practical terms this meant doing the following: (A) Creating 
a new exam with the desired series, and (B) Copying or importing any images in the original series into the new exam. 

CDR DICOM software provides greater flexibility with viewsets, enabling you to choose a new series for an existing exam, even if 
images are already part of the series. To do this for a currently open exam, perform the following steps: 

1. Click Series > Select and choose an alternate series in the dialog box. Be sure that the series you select has enough view 
boxes to accommodate the images in the original series. If you don't, CDR will merge as many of the images as it can into 
the alternate series, but it will detach the remaining ones. 

2. Click the Use button to replace the original series with the one you've just selected. In CDR DICOM, we call this new 
series the active one. The original series is not deleted, but it is no longer the active viewset in the exam. 

3. To review these changes, open the CDR Administration Utility and find the patient exam you just modified. You should 
find both viewsets listed, along with the images, in the upper pane of Administration Utility window. The active viewset will 
be indicated by a dark icon, the inactive viewset by a gray icon.   

Delete Images and Exams 

Exams and images cannot be deleted from the CDR client, as was possible in previous versions of CDR, using commands in the 
File Maintenance menu. Deletion of patient exams and images is managed within the CDR Data Administration Utility, using a multi-
tiered strategy to ensure that data is protected from accidental deletion. 
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The steps to delete either exams or images are similar, as described below: 

1. Start the CDR Data Administration Utility. The left pane of the utility displays a list of folders, sorted alphabetically, 
containing all the patients in the database and their exams. 

2. Navigate the patient list as follows: select a Patient folder in the left pane to display the list of exams in the upper right 
pane; select an Exam (Study) folder in the left pane to display the list of viewsets and exams in the upper right pane. 

3. Select a patient, exam, series, or image to delete. (Patient(s) can only be deleted using the upper right pane, when the All 
Patient folder is opened.) If you choose to delete a patient, all the exams, series, and images associated with that patient 
will be deleted as well. The same is true for exams, where all the viewsets and images associated with that exam will be 
deleted. 

4. Click Delete from the Edit menu, which will move the affected items to the CDR Recycle Bin (below the patient folder list 
in the left pane). 

5. To remove the items completely, purge them from the CDR Recycle Bin. 

Recover Images and Exams 

In the event exams and images are accidentally deleted, or appear to have been lost, they may be recoverable from the CDR 
Administration Utility. 

By using the CDR Administration Utility, it may be possible to recover deleted images and exams. When items are deleted in the 
CDR Administration Utility, they are first moved to the CDR Recycle Bin. To restore items found in this location, open the CDR 
Recycle Bin and select Undelete from the Edit menu.   

If the items have been purged from the CDR Recycle Bin, they may still be retrievable from the Windows Recycle Bin. Retrieving 
items from the Windows Recycle Bin requires a few extra steps, however. 

1. Open the Windows Recycle Bin (this icon can usually be found on your Windows desktop). 

2. Select the items you want to restore. In the Windows Recycle Bin, exams and images items may or may not be grouped 
together, so be sure to select all the items you want to restore to the database. 

3. Click Restore. 

4. Open the CDR Administration Utility and click Validate from the Tools menu. Validate will create records in your database 
for the deleted items. 

5. Proceed through the Validate (Database Integrity) wizard. One of the screens in the Validate wizard will report images that 
do not have corresponding database records. On this screen you should find images you want to recover. 

6. Click Add Records and continue with the wizard. Click Finish on the last screen. 

Reattaching Images 

Images cannot be deleted from the CDR client, as was possible in previous versions of CDR. Instead, images may be "detached" 
from the viewset (Xray / Image > Detach). Detaching an image removes it from the viewset, but does not delete it from the patient 
study. Once an image is detached, it will appears in the CDR Administration Utility with an "X" mark on it to signify that it is not part 
of the active viewset for that study. 

To reattach an image, perform the following steps: 

1. Start the Data Administration Utility and select the appropriate patient and study from the left pane. A list of all images for 
that study, both assigned and detached, will appear in the upper right pane. 

2. Select a detached image (it will have an "X" marked on top of it). 

3. Drag-and-drop the item into any empty view box that appears in the active viewset (lower right pane). 

4. The image has been reattached. It now appears in the active viewset and the "X" mark is removed from the image 
icon.Gestion de la base de données 

Database Management 

Database Integrity 

The functions found within CDR Data Administration provide accessible and easy ways to maintain the integrity of patient and image 
information stored in your database. There are several main tools in CDR Data Administration: 

--  DICOM Import / Export (also includes support for CD-ROM or other DICOM-compatible media) 

--  Compress / Uncompress Images 
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--  Send Images to Remote Server 

--  Detach Images 

--  Delete / Undelete / Purge Images 

--  Validate Database Integrity 

--  Search by Patient and by Study 

--  Refresh Database 

--  Edit Volumes 

--  Edit Patient Information 

Each tool is described as a separate topic within this help file. 

Database Validation 

This tool checks the data integrity of patient and image information stored in the database. To expedite the validation procedure, it 
has been designed as a wizard containing several selection screens and a results page. 

The Database Integrity Wizard performs the following tasks: 

--  Identifies the location of stored images 

--  Identifies image files without corresponding database records 

--  Identifies database records without corresponding image files 

--· Adds database records for missing image files 

Although there may be more than one path or location on your system where images are stored, only one path can be validated at a 
time. While validating the selected path, the wizard may identify images that are not associated with a corresponding record in the 
database. In this case, you have the option of deleting these images or adding records automatically to accommodate the images. 

The wizard will also identify missing database records, which can be added to the database or deleted. 

Database Searches 

To help you use the tools in CDR Administration, a search feature is available. Searches can be performed at the patient or at the 
study level, using one or more of the fields provided in the Search dialog box. 

The Search dialog box provides, essentially, three different avenues for retrieving  information in your database. 

1. The first method is to search by patient, using the patient-specific fields found in the dialog box. To follow this approach, 
select Patients from the drop-down list on the dialog box and add as much, or as little, information as you wish in the 
Patient Information section. Clicking OK retrieves Patients whose information corresponds to the search parameters you 
entered. 

2. The second method  is to search by study, using the study-specific fields found in the dialog box. To follow this approach, 
select Studies from the drop-down list on the dialog box and add as much, or as little, information as you wish in the Study 
Information section. Clicking OK retrieves Studies whose information corresponds to the search parameters you entered. 

3. The third method is to search by image, using the image-specific fields and volume location drop-down list found in the 
dialog box. To follow this approach, select Images from the drop-down list on the dialog box and add as much, or as little, 
information as you wish in the Image Information section. Clicking OK retrieves Images whose information corresponds to 
the search parameters you entered. 

Resending Database Queries 

In CDR DICOM, clients and servers function as separate applications. CDR servers receive requests for image storage and respond 
to query and retrieval requests from one or more CDR clients. Although CDR client and servers interact with each other during 
patient, study, and image information exchanges, updates made by one CDR client -- for example, a change in patient information -- 
may not be immediately visible to another CDR client, even though they are both connected to the same server. 

Refreshing the database enables the current CDR client to retrieve the latest information from the server's database. If the 
information you are trying to retrieve has been added by another CDR client, remember that patient studies are updated on the 
server at the end of CDR sessions. To ensure that the information added by a specific client is saved to the server's database, close 
the CDR session running on that workstation.   
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Volume Information 

Volume information is maintained in your CDR database to identify paths where images are stored on your system. Should it 
become necessary to make changes to volume information --whether to add, modify, or delete an image archive -- such changes 
can be made using the Volume editing tool. 

It is important to note that changing the volume paths can affect the ability of CDR to locate and retrieve images. For this reason, we 
recommend that you do not make changes to the Volumes unless assisted or directed by qualified support personnel. 

Image Import and Export 

Importing and Exporting DICOM Information 

The DICOM Import tool imports DICOM studies and images to the current database from another drive location. The import source 
can be any valid DICOM file or archive, located on an accessible volume path or on physical media. CDR DICOM will read into the 
current database all of the records contained within a "DICOMDIR" file set. Each record contains Patient / Study / Series / Image 
information and populates the tables in the connected database appropriately. 

The DICOM Export tool exports patients, DICOM studies, and images to another drive location. You have the option of creating a 
new storage archive for these items at their destination, or simply use a folder location that exists already. 

Reading Images from Media 

The Setup DICOM CD-ROM tool copies DICOM exams from CD-ROM or other DICOM compatible media to the current database. 

It is important to note that this operation will only read exams that have already been converted to DICOM. This characteristic 
distinguishes Setup DICOM CD-ROM from the Setup CD-ROM option found in previous versions of CDR. Exams previously 
archived to CD-ROM must be converted to DICOM format first (using the Conversion Utility) and then imported into the current 
database. 

Compressing Images 

Compressing X-ray images offers several benefits, including: 

• Increased efficiency in the use of space allocated for storing images 

• Increased image retrieval and display time because the file sizes are smaller 

• And for the same reason – increased portability and electronic mailability 

The following compression formats are supported: 

• JPEG2000 Lossless (2:1 compression): no comparable format in previous versions of CDR 

• JPEG2000 Near Lossless (5:1 compression): compares with Lead PQ1 in previous versions of CDR 

• JPEG Lossy (20:1 compression): compares with JPEG in previous versions of CDR 

For steps on compressing images using the Data Administration, click here. 

Sending Files to a Remote Server 

This advantages provided by this operation will likely be more relevant to multi-office practices that back up patient records to a 
central server or share patient patient records between several locations. In these examples, the practices could use more than one 
server -- a local server that their office workstations connect to, and a remote server for archiving and storage. You have the option 
of sending all the studies for a particular patient, or just the studies and images you want. 

To send all the studies for a particular patient to a remote server: 

1. Open the All Patients folder in the Data Administration utility. 

2. Select the patient(s) whose files you wish to send.   

3. Go to the File menu and click on Send to Remote Server, which displays the appropriate dialog box. In the dialog box, 
select a registered remote server from the drop down menu or fill in the text boxes to add a new server. 

4. Click the Verify button to confirm the connection to the remote server is available. 

5. Click the Send button if the remote server is ready. 
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To send some of the studies for a specified patient: 

1. Open the All Patients folder and double click on the patient's name in the upper right pane. 

2. Go to the File menu and click on Send to Remote Server, which displays the appropriate dialog box. In the dialog box, 
select a registered remote server from the drop down menu or fill in the text boxes to add a new server. 

3. Click the Verify button to confirm the connection to the remote server is available. 

4. Click the Send button if the remote server is ready. 

To send some of the images for a selected study: 

1. Open the All Patients folder, double click on the patient's name in the upper right pane, and then double click on the study 
whose images you want to send. 

2. Go to the File menu and click on Send to Remote Server, which displays the appropriate dialog box. In the dialog box, 
select a registered remote server from the drop down menu or fill in the text boxes to add a new server. 

3. Click the Verify button to confirm the connection to the remote server is available. 

4. Click the Send button if the remote server is ready. 

Editing and Merging Information 

Edit Patient and Study Information 

Patient and study information constitute critical data in CDR DICOM. Notwithstanding their importance, it is sometimes necessary to 
revise this information to maintain database records that can track accurately with actual patient and study data. Editing patient 
information in the Data Administration area provides an accessible tool to update and / or clarify patient information in your 
database. 

Changes in patient information cascade automatically through all of the studies and images for that patient. Changes in study 
information occur similarly, updating all the images in that changed study. 

Merge Patient Studies 

To keep your patient database up-to-date, you may find it convenient to combine studies. Combining previous studies with newer 
ones when a patient has married and taken a new last name is one example when using the merge study feature can be helpful. 
You also have the option of merging all the studies for a particular patient, or just the studies you want. 

To merge all of the studies for a specified patient: 

1. Open the Search Results folder in the Data Administration utility. 

2. Select the patient's name in the upper right pane. (By selecting the patient, you choose where you want the studies to be 
moved from.) 

3. Go to the Edit menu and click on Merge Patients. In the dialog box, select the target patient folder (where you want the 
studies to be moved to). 

4. Click the Merge button to move the studies to the target location. 

To merge some of the studies for a specified patient: 

1. Open the Search Results folder in the Data Administration utility. 

2. Double click on the patient's name in the upper right pane. (By opening the studies for the selected patient, you are able 
to choose which studies you wish to  move from that patient.) 

3. Go to the Edit menu and click on Merge Patients. In the dialog box, select the target patient folder (where you want the 
studies to be moved to). 

4. Click the Merge button to move the studies to the target location. 

Modify Volume Information 

Once you have selected a volume path to be modified, the editing changes are made in the Modify Volume Info dialog box. 
Additional information about the volume path, including whether it is a network resource or CD-ROM media, can also be indicated 
here. By modifying the volumes, information about them in the image storage database is updated. 

It is important to note that changing the volume paths can affect the ability of CDR to locate and retrieve images. For this reason, we 
recommend that you do not make changes to the Volumes unless assisted or directed by qualified support personnel. 
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Deleting and Recovering Files 

Restoring Files 

To minimize the risk of deleting images inadvertently, CDR employs a layered strategy to ensure that only the images really 
intended for deletion are removed from the database. In the initial layer, deleted images are moved to CDR's Recycle Bin, which is 
located in the left pane of the Data Administration window. To restore (or undelete) images from CDR's Recycle Bin, open the bin, 
select the appropriate file, and select Undelete from the Edit menu. 

If images in CDR's Recycle Bin are deleted ("purged"), they are moved to the Windows Recycle Bin, where, if necessary, they can 
still be saved from deletion using Windows Restore option. 

When a patient is undeleted, all of the studies, viewsets, and images for that patient are also undeleted (restored from CDR Recycle 
Bin). When a study is undeleted, all of the viewsets and images for that study are also undeleted (restored from CDR Recycle Bin). 
When an active viewset is undeleted (restored from CDR Recycle Bin), all of the images are reassigned to that viewset. When an 
image is undeleted (restored from CDR Recycle Bin), it is reassigned to the currently active viewset. 

If the items have been purged from the CDR Recycle Bin, they may still be retrievable from the Windows Recycle Bin, located on 
your Windows desktop 

Deleting and Purging Files 

As part of the effort of managing a database, it is sometimes necessary to remove files that are no longer needed or are not suitable 
for long-term storage. To assist with these efforts, the CDR Data Administration provides "file deletion" and "file purge" for stepping 
users through the database record and  image deletion process. 

Images that are deleted are moved to the CDR Recycle Bin. There, they can either be restored to active status in the database or 
marked for purging. If the files are purged, they are moved to the Windows Recycle Bin, where they can still be retrieved and 
restored to the database. Otherwise, they can be deleted. 

When a patient is deleted, all of the studies, viewsets, and images for that patient are also deleted (moved to CDR Recycle Bin). 
When a study is deleted, all of the viewsets and images for that study are also deleted (moved to CDR Recycle Bin). When an 
active viewset is deleted, all of the images are unassigned. The images can be reassigned to another viewset or deleted (moved to 
CDR Recycle Bin). When an image is deleted, it is unassigned and can either be reassigned to another viewset or deleted (moved 
to CDR Recycle Bin).   

When studies and images are purged, their database records are removed as well. This helps to manage and maintain the current 
database so that image files and database records remain correctly mapped.   

Attached and Detached Images 

When you choose to detach an image, it is retained as part of the patient study, but it is not displayed in the series. Detaching offers 
greater versatility in the way viewsets are managed, enabling you to keep active and inactive viewsets and attached and detached 
images. 

By detaching and attaching images, you're able to refine exams so they include appropriate images in an appropriate series. 
Frequently, relevant images are spread across several exams, making comparisons sometimes difficult. Using the Administration 
Utility, you can ensure the most appropriate viewset is active and then drag-and-drop images (from the upper right pane) into the 
viewset (at the lower right pane). Images that you want to hide from display, but want to retain, can be detached from their current 
viewset. Once an image is detached, it can be deleted or reattached to its original, or new, viewset. 

In some situations, it may be possible for images to be automatically detached from their original viewset and become "unassigned." 
One of the situations in which this could occur is the following: 

Study A has two viewsets. The currently active viewset has 10 images in 10 view boxes, the alternate (currently inactive viewset) 
has 8 view boxes. If you choose to change the status of the viewsets, making the inactive one active, there would not be enough 
view boxes in the 8-box-viewset to accommodate the 10 images in the previously active viewset. As a result, 2 of the images would 
be detached (or unassigned), meaning they would be retained in the study, but they would not be displayed in the current viewset. 
To eliminate this problem when working with multiple viewsets, make sure the alternate viewset (the one you wish to make active) 
has a sufficient number of view boxes for the number of images in the current viewset (the one to become inactive).Data 
Administration Window 

Administration Window Locator 

The following graphic is a sample of a typical CDR Data Administration window.  
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Server Information 

Server Connections 

The DICOM Server for CDR (also called CDRServer) is designed to receive requests for image storage, query, and retrieval from 
workstation clients in its network. CDRServer stores image information in an SQL / ODBC database and stores the images 
themselves in an accessible hard disk location. 

Before CDRServer can be set up, some basic information about the TCP / IP connection between the DICOM Server and its 
workstation is required. Although obtaining this information in your system environment falls outside the scope of this topic, learning 
what information will be needed (as described in the next paragraph) will be helpful during the setup process. 

Setting up CDRServer is accomplished in CDR Options (under CDR's System menu). Select the  Data Access tab and click on the 
Advanced button. Click on the Edit Servers button and then on the Insert / Modify button and have the following information ready: 

--  Remote Title (name) of the server (like CDRServer) 

--  Local Title (name) of the workstation 

--  IP Address of the server or its IP name (like WinSrvr) 

--  Port where the server is listening for TCP/IP connections (this number is 1004 by default) 

Registered Workstations 

Workstations that can communicate with a particular server are said to be "registered" with that server. Registered workstations can 
send images to the server and retrieve them. A list of workstations registered with CDRServer can be found on the CDR 
Workstations dialog box. 

Active Connections 

When a workstation is actively communicating with CDRServer, information about the client and its connection is available from 
CDRServer. In addition, the client / server connection itself can be either refreshed or disconnected using the Active Connections 
dialog box. 

When a client and CDRServer are actively connected, it is possible to view messages exchanged between them when the log 
window is open. DICOM operations are also reported and can be displayed by clicking the Refresh button on the Active 
Connections dialog box. Because DICOM commands and responses are exchanged quickly in real time, it may not always be 
possible to view this information. The Refresh button can also be used to detect new connections to CDRServer. 

Like Refresh, the Disconnect button is really intended for use by a network administrator monitoring communication between the 
server and its clients. Disconnect will terminate the selected client / server connection. 
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Server Settings 

Configuration Settings 

Several settings in CDRServer are configurable. The following list identifies these items, which can be set or edited in CDR Options. 

--  IP Port 

--  Local AE Title 

--  Error Log File 

--  (DICOM) Message Log File 

--  (ODBC) Database Log File 

--  Image Directory 

Database Configuration 

CDRServer uses an ODBC / SQL database to store information about patients, images, and other related CDR data. The database 
contains image information only; the actual image file (in DICOM Part 10 file format) is stored separately on the server's hard drive. 

The primary tables in the CDR Database are based on a simplified DICOM real world model of Patient, Study, Series, and Image. 
These tables are supplemented by others, including a Volume table for information on storage volumes, hard drives, and network 
drives, and a Workstations table, for information about the workstations connected to the network. 

Log Windows and Files 

DICOM Log File 

The CDR DICOM Server log window provides text information about messages and errors generated during DICOM associations. 
When you set up a DICOM server, you have the option to create a log file for this information and to specify its location. 

To create a log file for CDR DICOM Server, open CDR Options (found under CDR's System menu), select the Data Access tab and 
click on the Advanced button. On the Local property sheet, enter a name and location for the log file and click OK.   

To view messages and errors generated during a DICOM association between CDR DICOM Server and one of its registered 
workstations, perform the following steps: 

--  At the CDR DICOM Server dialog box, click on the Server menu. 

--  If the server is active (Start Server is check marked), select this item again to stop the server. When the server is inactive, the 
check mark is removed, and the menu title on the dialog box changes to "CDR DICOM Server - Inactive." 

--  Select the Log Window item from the Server menu, which opens the log window. 

--  After reviewing the messages and / or errors, restart the server by clicking on the Start Server menu item again. 

Database Log Window 

The CDR Database log window provides text information about errors generated during database transactions. When you set up a 
server in CDR for direct access to an ODBC / SQL database, you have the option to create a log file for this information and to 
specify its location. 

To create a log file for CDR Database, open CDR Options (found under CDR's System menu), select the Data Access tab and click 
on the Advanced button. On the ODBC Errors property sheet, click the check box to enable error logging and enter a name and 
location for the log file and click OK.   

To view errors generated during database transactions between CDR Server and one of its registered workstations, perform the 
following steps: 

--  Find the ODBC error log file on your system. Its path was defined in CDR Options as described above 

--  Select the log file. If the file is already associated with a text editor (like Notepad or WordPad), double click on the file to open it. If 
the file is unassociated, press and hold down the <SHIFT> key and right click on the file. When the Open With dialog box opens, 
select a text editor and click OK. 
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A 
acquisition mode: The way that images are captured from a particular hardware device (intraoral sensor, video camera, panoramic 

machine, or other source). 

C 
client: Computer hardware and software that requests access to, storage of, or retrieval from images stored by the server. 

D 
DICOM: Digital Imaging and Communications in Medicine. An evolving standard promoting a common set of guidelines for the 

exchange of medical images between diverse hardware and software implementations. 

DICOMDIR: An index file or directory that is used to open a group of DICOM files. 

driver: A program that enables software applications to communicate with particular hardware devices. 

E 
exam: A number of view boxes arranged in a particular pattern or series, created for a specific patient. 

exam window: A customizable view of the current exam, displaying patient, viewset, and other information. 

R 
report: A document based on a template, using the template's contents and structure, but then tailored to the particular needs of the 

report. 

S 
series: A group or pattern of view boxes created for a specific exam type (X-ray, video, or panoramic). 

server: Computer hardware and software that responds to client requests for stored images. 

study: In CDR, a study consists of a patient exam and a series. 

T 
target frame: A rectangle in the CDR exam window that is used to position and display an image. Also called a view box. 

template: A document designed for reusability. Templates contain general information (text and graphics) to expedite the creation 
of specific documents (reports). 

tooltip: Concise, context-specific help provided within dialog boxes. To access this type of help, click the question mark (?) on the 
title bar and then click on any area inside the dialog box. Also called field-level or context-sensitive help. 

V 
view box: A rectangle in the CDR exam window that is used to position and display an image. Also called a target frame. 

viewset: A group or pattern of view boxes created for a specific exam type (X-ray, video, or panoramic). Also called a series. 

Z 
zoom window: A customizable view of the current image, providing access to various image enhancement and measurement tools. 
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